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1. UVOD 

Cilj istraživanja diplomskog rada je teorijska i praktična primjena software-a za obradu 3D 

podatka na primjeru iz poljoprivredne mehanizacije. Cilj je bio utvrditi potrošenost dlijeta 

lemeša pluga; kako bi se to moglo izvesti prvo je bilo potrebno stvoriti 3D modele novoga i 

korištenog dlijeta u programu Agiosft Metashape te ih kasnije obraditi i usporediti u 

programu CloudCompare. 

Teorijski, ono predstavlja rezanje površinskoga dijela „cjelice”, njezino podizanje na kosinu 

plužne daske i prevrtanje za oko 135 °. Pri tome se odvojena plastica lomi, usitnjava, rahli 

te miješa. To je izrazito težak i skup posao, jer zahtijeva znatan utrošak rada ljudi, strojeva 

i energije po jedinici površine. Od svih dijelova pluga pri oranju je najopterećeniji lemeš te 

se on i najbrže troši. Na proces njegovoga trošenja djeluje veći broj čimbenika s različitim 

intenzitetom. Među najznačajnijima su tip i vlaga tla, oblik, veličina, tvrdoća i zbijenost 

čestica tla te brzina kretanja agregata pri oranju. Zbog trošenja materijala lemešu se tupi 

oštrica i mijenja prvotni konstrukcijski najpovoljniji oblik. Oranje tupim lemešom je, zbog 

porasta otpora i povećane potrošnje goriva, otežano, nekvalitetno i skupo. Istrošen lemeš 

treba skidati i zamijeniti novim. Time se gubi vrijeme u povoljnom agrotehničkom roku i 

smanjuje planirani učinak stroja. Zbog toga se u posljednje vrijeme nastoji izraditi lemeše 

poboljšane kakvoće i produženoga vijeka trajanja. Pri tome se primjenjuje velik broj 

različitih materijala i postupaka izrade. Cilj ovog istraživanja bio je odabrati najjeftiniji 

materijal i postupak obrade lemeša, sa svrhom uštede vremena i snižavanja troškova pri 

obradi tla oranjem. U tom smislu obavljen je veći broj mjerenja vezanih za utvrđivanje 

trošenja mase, tijela i vrha lemeša, očuvanja oštrice i gubljenja početnog oblika. Tijekom 

istraživanja, s ciljem izračunavanja učinka i cijene izrade različitih tipova lemeša, praćene 

su zbijenost tla i brzina rada. (Banaj i sur., 2008.) 
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2. PREGLED LITERATURE 

Dosadašnjim istraživanjima lemeša različite tvrdoće konstatiralo se da je površinska tvrdoća 

jedna od najvažnijih karakteristika otpornosti na trošenje lemeša. Najtrošeniji dijelovi radne 

površine lemeša su vrh i oštrica. Posljedica toga očituje se u gubitku mase i promjeni 

dimenzija lemeša. Zastoji koji nastaju uslijed istrošenosti i zatupljenosti lemeša iziskuju 

određeno vrijeme za zamjenu novima, što rezultira troškovima. Direktni troškovi su cijena 

novih lemeša i rad za zamjenu istrošenih. Indirektni troškovi se mogu sastojati u povećanoj 

potrošnji goriva tijekom rada i u lošijoj kvaliteti oranja. Ti indirektni troškovi mogu značajno 

porasti. Jedan od mogućih rješenja problema trošenja lemeša je navarivanje lemeša tvrdim 

slojevima na vrh oštricu. Ispitivani će biti lemeši izrađeni od različitih materijala praćenjem 

promjene karakterističnih dimenzija i gubitka mase. Cilj istraživanja je, da se na osnovu 

usporedbe rezultata lemeša utvrdi koji materijal, odnosno zaštitni sloj daje veću otpornost 

trošenju. (Putnik i sur., 2017.) 

Richardson (1967.) je utvrdio da su neki prirodni abrazivi u tlu veće tvrdoće od površinske 

tvrdoće čelika od kojeg su se do tada izrađivali lemeši. Isti autor je proveo istraživanja 

lemeša izrađenih od čelika različite tvrdoće i došao do zaključka da je površinska tvrdoća 

najvažniji čimbenik otpornosti lemeša na trošenje. Sedamdesetih godina prošlog stoljeća 

počinju pokusi s nanošenjem materijala povećane tvrdoće na oštrice dijelova oruđa za 

obradu tla. Moore (1975.) provodi laboratorijska i poljska istraživanja otpornosti materijala 

na trošenje i dolazi do zaključka da, uz površinsku tvrdoću, na otpornost na trošenje značajno 

utječu i kemijski sastav i struktura materijala. U Hrvatskoj su prva istraživanja s navarenim 

lemešima provedena sredinom osamdesetih godina (Tot, 1985.), a rezultati su pokazali da 

su navareni lemeši bili znatno trajniji od standardnih nenavarenih. Nadalje, isti autori navode 

da na vijek trajanja lemeša veliki utjecaj imaju mehanički sastav i vlažnost tla u trenutku 

obrade. Emert i sur. (1986.) navode da su tzv. standardni lemeši zatupjeli već nakon 7 do 8 

sati rada, dok su navareni lemeši došli u takvo stanje nakon 80 sati rada. Analizirajući rad s 

tupim lemešima, utvrdili su da je došlo do povećanja otpora pluga i klizanja pogonskih 

kotača traktora, te smanjenja radne brzine i učinka agregata. Mikloš i Tot (1992.) navode da 

je kod zaštite lemeša važan i pravilan izbor međusobnog odnosa koeficijenta trošenja 

osnovnog i dodatnog materijala, te izbor debljine nanesenog sloja. Fielke (1996.) je 

istraživao utjecaj trošenja oštrica oruđa za obradu tla na potrebnu vučnu silu na tlu s 85 % 

pijeska pri različitim dubinama i brzinama, te došao do zaključka da u usporedbi s 
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naoštrenim oštricama potrebna vučna sila kod oruđa s zatupljenim oštricama može porasti i 

do 80 %. Natsis i suradnici (1999.) su istraživali utjecaj tipa tla, vlažnosti tla i naoštrenosti 

lemeša na potrošnju energije, učinak i kakvoću oranja. Na osnovi dobivenih rezultata 

zaključuju da se na glinenim i ilovastim tlima trošenje oruđa smanjuje s povećanjem 

vlažnosti tla, a na pjeskovitim tlima se s povećanjem vlažnosti tla povećava i trošenje. Isti 

autori navode da je pri radu sa zatupljenom oštricom lemeša došlo do povećanja potrebne 

vučne sile za 62 %, povećanja potrošnje goriva traktora za 41 % i smanjenja učinka za           

30 %. (Horvat i sur, 2006.) 

2.1 Fotogrametrija 

Fotogrametrija (foto + gram + metrija), znanost i tehnika određivanja oblika, veličine ili 

položaja nekog objekta snimanjem, mjerenjem i interpretacijom fotografskih snimaka. 

Zasniva se na činjenici da snimka nastaje prema određenim geometrijskim i optičkim 

zakonitostima, pa je njihovim poznavanjem moguće na osnovi snimke djelomično ili u 

potpunosti rekonstruirati snimljeni objekt. Na osnovi jedne snimke mogu se odrediti 

dvodimenzijska svojstva objekta, odnosno provesti potpuna rekonstrukcija približno ravnog 

objekta (npr. zemljišta, pročelja zgrade) ili djelomična rekonstrukcija prostornog objekta 

(npr. obrisa nekog predmeta). Za određivanje trodimenzijskih svojstava objekta potrebno je 

načiniti dvije snimke, tzv. stereopar, iz različitih kutova snimanja. Takvo se snimanje naziva 

stereoskopskim, a fotogrametrijska rekonstrukcija uz pomoć stereoparova naziva se 

stereofotogrametrijom. Rekonstrukcija geometrijskih odnosa i veličina snimljenog objekta 

obuhvaća postupke orijentacije i izmjere. Ti se postupci u analognoj fotogrametriji provode 

optičko-mehaničkim uređajima. Znatno su fleksibilniji postupci analitičke fotogrametrije, 

gdje se rekonstrukcija provodi numerički, uz pomoć računala. Najnoviji postupci digitalne 

fotogrametrije oslanjaju se na snimke učinjene digitalnim kamerama ili na naknadno 

digitalizirane snimke učinjene klasičnim tehnikama. Digitalna fotogrametrija kombinirana s 

drugim, npr. projektorskim postupcima, te u sprezi s tehnikama računalne obradbe slike, 

omogućuje gotovo u potpunosti automatizirano dobivanje trodimenzijskoga digitalnog 

modela objekta. Budući da se fotogrametrijsko snimanje ne obavlja na samom objektu, već 

s udaljenosti, područje je njegove primjene široko. U geodeziji se aerofotogrametrijom 

znatno ubrzava i olakšava izmjera zemljišta i izradba karata, dok se u inženjerstvu 

primjenjuje pri trasiranju prometnica, u hidrotehnici, urbanizmu i prostornom planiranju. 

Aerosnimke se često rabe i u arheologiji, geologiji i geografiji, a ključna im je primjena i za 
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vojne namjene. Terestrička fotogrametrija se već dulje vrijeme primjenjuje u kriminalistici, 

arhitekturi i zaštiti spomenika kulture, dok su novi digitalni postupci znatno proširili 

primjenu, npr. u medicini i industriji. Fotogrametrijskim se postupcima mogu pratiti i 

pomaci ledenjaka, deformacije zgrada, ili pojava i širenje pukotina na dijelovima 

konstrukcija. Konačno, bez fotogrametrije nije zamislivo ni kartiranje i proučavanje 

površine planeta. U Hrvatskoj fotogrametrija ima dugu tradiciju. Već je 1897. objavljena 

prva knjiga iz tog područja na hrvatskom jeziku Kružić, F. (1897): Fotogrametrija i praktični 

dio tahimetrije, 1947. osnovana je katedra za fotogrametriju na Tehničkom fakultetu u 

Zagrebu, a 1961. utemeljen je Zavod za fotogrametriju kao prva samostalna ustanova te 

djelatnosti. (Perić, 2017.) 

Metoda nastala iz imena photo-svijetlo, gram-crtanje, metry-mjerenje, koja se bavi 

dobivanjem informacija određenih fizičkih objekata kroz proces snimanja, mjerenja te 

tumačenja fotografske slike. Dakle, radi se o metodi koja za mjerenja koristi fotografije 

objekata, posebice kada je riječ o određivanju točnih položaja određenih površina. 

Fotogrametrija se oslanja na prikupljanje podataka iz digitalnih fotografija, težeći tome da 

obradom tih resursa izvuče što više pouzdanih informacija za daljnju uporabu. Tehnika 

fotogrametrije spada u disciplinu daljinskog očitavanja, zbog korištenja naprednih 

proračuna i analiza izračuna objekata bez fizičkog kontakta pri obradi prikupljenih 

informacija. Discipline koje su usko povezane s temom su: optika, projekcijska geometrija, 

daljinsko očitavanje (engl. remote sensing) i danas aktualno polje računalne vizije (engl. 

computer vision) - nauke koja se koncentrira na proces pribavljanja, obradu i analizu slika s 

ciljem kreiranja korisnih informacija. (Piskrec, 2019.) 

Optika, kao i matematika su kritične i inicijalne komponente za fotogrametrijsko 

izračunavanje, s obzirom da se fotogrametrija oslanja na znanstvenu analizu fotografija. 

Zakoni koji svoje korijene vuku još iz petnaestog stoljeća, zasnivaju se na linearnoj, odnosno 

geometrijskoj ili „pravilnoj” perspektivi koja potiče iz Euklidove geometrije. Danas se 

također umjetnici sluţe metodama Euklidove geometrije za precrtavanje 3D slika iz realnog 

svijeta na platno, koristeći proces Kamere obskure (engl. camera obscura) ili pak „golim 

okom” Cilj fotogrametrije je potpuno suprotan jer funkcionira na principu korištenja 

matematike kojom nastoji izvući što više pouzdanih informacija iz fotografije, odnosno 

dvodimenzionalnog medija, te time stvoriti 3D modele. Analiza fotografija i “planerskih” 

stolova (engl. photography and plane tables analysis) se koristila na slikama koje su bile 
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napravljene s visina, u tadašnje doba s brda, ili upotrebom letećih balona i “zmajeva” (eng. 

kites). Jednom kada su slike bile napravljene, kombinacijom tehnike linearne perspektive i 

jednostavne matematike te usporedbom varijabli izračunavala se točna visina objekata 

unutar slika, a time i ostali omjeri, što se učestalo koristilo u kartografiji tog vremena. 

“Stereocrtači” (engl. stereoplotters) su uređaji koji kreiraju stereoskopske slike, one koje 

prikazuju prostor u tri dimenzije, odnosno koje prostoru dodaju komponentu dubine. To se 

postiže uz pomoć tehnologije za automatiziranje izračuna objektne pozicije na temelju dvije 

slike različitih perspektiva koje se preklapaju i koje su optički poravnate. Slijedom toga 

nastaju mnogi izumi: „plutajuća” oznaka(engl. floating mark), „stereo -usporednik“ (engl. 

stereocomparator), „stereo - autograf“ (engl. stereoautograph), „zračna kamera za 

stereoskopske fotografije“ (engl. serial – photo aerial camera), itd. Uz pomoć njih se 

počinje automatizirati visinska analiza na temelju fotografija u ranom dvadesetom stoljeću. 

Do 1930-ih godina, slijedom rafinirane tehnologije zračnih izračuna, zračna stereoskopska 

slika postaje glavna metoda prilikom izrade navigacijskih karata. (Piskrec, 2019.) 

Fotogrametrija je umjetnost, znanost i tehnika određivanja oblika, veličine ili položaja nekog 

objekta nastalog pomoću fotografskih snimaka. Zbog svoje efikasnosti fotogrametrija se 

razvila u visoko pouzdanu i preciznu tehnologiju mjerenja. Pomoću jedne snimke moguće 

je odrediti dvodimenzionalna svojstva objekta, dok za rekonstrukciju trodimenzionalnog 

objekta potrebno je napraviti minimalno dvije fotografije. Unutar ovog projekta koristio sam 

aerofotogrametriju. Kod aerofotogrametrije, objekti se snimaju putem satelita, zrakoplova 

ili bespilotnih letjelica. Tijekom snimanja, koriste se fotografije kalibriranih kamera, 

pomoću koje je olakšano određivanje orijentacije snimke. (Vlatković, 2018.) 

Fotogrametrija je općenito tehnika mjerenja oblika, veličine ili položaja odabranog objekta 

pomoću interpretacije niza fotografija (Sajinkumar i Oommen, 2018.). Pojam fotogrametrija 

prvi je uveo pruski arhitekt Albrecht Meydenbauer 1867. godine tijekom rada na 

topografskim i elevacijskim crtežima (Albertz i Wiedemann, 1996.). Metoda se oslanja na 

informacije dobivene od barem dvije fotografije koje su slikane na različitim lokacijama. 

Zbog različitih lokacija snimaka moguće je stvoriti zajedničke linije koje se pomoću 

matematičkih metoda presjecaju i dobivaju trodimenzionalne točke objekta od interesa 

(Sajinkumar i Oommen, 2018.). Digitalna fotogrametrija zapravo je podvrsta 3D skeniranja 

koja se temelji isključivo na digitalnim fotografijama. Pomoću programa (pr. često 

korištenih Autodesk 123d Catch i Agisoft PhotoScan, ali i drugih) analiziraju se sličnosti 
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među fotografijama i na temelju njih dobivaju podatci o dubini, obliku te teksturi objekta. 

Za dobivanje geometrije objekta pomoću digitalne fotogrametrije najčešće se koriste 

Structure-from-Motion (SfM) i Multi-View Stereo (MVS) metode (Ružić i sur., 2014.). 

Pomoću navedenih tehnika i računalnog programa, to jest preklapanjem fotografija slikanih 

iz različitih kuteva, proizvodi se trodimenzionalni oblak točaka u proizvoljnom 

koordinatnom sustavu, koji se može precizno georeferencirati u svrhu redovitog praćenja i 

daljnjih analiza (Pikelj i sur., 2015.). SfM tehnika stvara 3D oblak točaka procjenjujući 

lokaciju i orijentaciju objekata na fotografijama i parametre kamere, dok MVS koristi 

tradicionalnu fotogrametrijsku tehniku prilagođenu nizu fotografija i podatke SfM metode 

te potom stvara još veći broj 3D točaka (Gomez i sur., 2015.). Ovakva digitalna tehnika 

dobivanja 3D modela razvijena je tek u posljednjem desetljeću razvojem digitalnih 

fotoaparata visoke rezolucije, računalnih algoritama koji uočavaju korelacije između 

fotografija te bespilotnih letjelica. Osnovni uvjeti pri snimanju za digitalnu fotogrametriju 

moraju biti zadovoljeni kako bi program uspješno izradio model iz niza fotografija: 1) objekt 

je potrebno fotografirati iz što više kuteva i moraju se obuhvatiti sve strane objekta pri 

različitim visinama, 2) u nizu fotografija svaka susjedna fotografija mora sadržavati ≥ 60 % 

dijela prethodne fotografije (Tominić, 2017.), 3) za kasniju obradu podataka i 

georeferenciranje objekta nužno je da na najmanje 3 fotografije budu vidljive 3 ili više 

kontrolne točke (Tominić, 2017.), 4) na fotografijama bi u prvom planu trebao biti 

istraživani objekt, a što manje zahvaćenog okolnog prostora te 5) nepoželjne su sjene i jako 

sunce jer one „sakrivaju“ pravu teksturu objekta u dobivenom modelu (iz toga razloga 

poželjno je fotografirati tijekom ravnomjernog osvjetljenja). Slika 2. Putanja kamere pri 

snimanju objekta SfM metodom (prema Bemis i sur., 2014.). U posljednje vrijeme za 

metodu fotogrametrija najviše se koriste bespilotne letjelice s ugrađenom kamerom (UAV- 

eng. unmanned aerial vehicle). Pomoću njih je uveliko olakšano slikanje iz raličitih kuteva 

i jednostavnije je obuhvatiti objekt iz svih strana pri različitim visinama, dok osoba koja 

upravlja letjelicom može biti na sigurnoj udaljenosti ne izlagajući se mogućim opasnostima. 

Nadalje, UAV (unmanned aerial vehicle) mora zadovoljiti određene uvjete kako bi se moglo 

koristiti za fotogrametrijsko snimanje: autonomija leta letjelice s preciznom putanjom okolo 

objekta, visoka kvaliteta fotografija i zaštita fotoaparata od treskanja i vanjskih utjecaja te 

letjelica mora biti opskrbljena opremom za navigaciju i snimanje (Tominić, 2017.). Pri 

snimanju klifa na Duilovu u provedenom istraživanju koristila se bespilotna letjelica, još 

poznata kao dron, pomoću koje je snimljeno 275 fotografija. Putanja leta UAV (unmanned 
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aerial vehicle) bila je 5  projektirana tako da svaka sljedeća fotografija u nizu sadrži određen 

postotak prethodne fotografije, to jest fotografije su se djelomično „preklapale“. Također, 

pazilo se da što više fotografija sadrži 3 ili više kontrolne točke kako bi georeferenciranje 

klifa bilo što uspješnije. (Stančec, 2020.) 

 2.2 Računalni program Agisoft Metashape 

Agisoft Metashape je samostalni program koji obavlja fotogrametrijsku obradu digitalnih 

slika (fotografije iz zraka i iz neposredne blizine, satelitske snimke) i generira 3D prostorne 

podatke koje se koriste u GIS aplikacijama, dokumentaciji kulturne baštine i proizvodnji 

vizualnih efekata kao i za neizravna mjerenja objekata raznih razmjera.Softver omogućuje 

obradu slika s RGB, toplinskim ili multispektralnim kamerama, uključujući sustave s više 

kamera, prostorne informacije u obliku oblaka gustih točaka, teksturiranih poligonalnih 

modela,georeferenciranih pravih ortomozaika i DSM/DTM. Daljnja naknadna obrada 

omogućuje uklanjanje sjena i artifact teksture iz modela, računanje indeksa vegetacije i 

izvlačenje informacija za karte poljoprivredne opreme, automatsko klasificiranje oblaka 

gustih točaka, itd. Metashape je sposoban za obradu od 50 000+ fotografija u lokalnom 

klasteru, zahvaljujući funkcionalnosti distribuirane obrade. Alternativno, projekt se može 

poslati u oblak kako bi se ulaganje u hardver svelo na najmanju moguću mjeru, a sve opcije 

obrade ostale su dostupne. Mudro implementirana tehnika digitalne fotogrametrije pojačana 

metodama računalnog vida rezultira pametnim automatiziranim sustavom obrade kojim, s 

jedne strane, može upravljati pridošlicau području fotogrametrije, ali, s druge strane, ima 

mnogo toga za ponuditi stručnjaku koji može imati koristi od naprednih značajki kao što je 

stereoskopski način rada i potpuna kontrola nad točnošću rezultata, sa detaljanim izvještajem 

koji se generira na kraju obrade. (Agisoft Metashape User Manual: Professional Edition, 

Version 1.6, 2020.) 

Agisoft Metashape napredno je programsko sučelje tvrtke Agisoft LLC. , koje se koristi za 

obradu fotografija, gdje se kod digitalnih fotografija stvara trodimenzionalan sadržaj. 

Temelji se na tehnologiji koja vrlo brzo omogućuje precizne rezultate, koje možemo dobiti 

pomoću bespilotnih letjelica (eng. Drone) ili digitalnih kamera. Preciznost snimke ovisi 

naravno o udaljenosti uređaja od objekta koji se snima, pa tako znamo da će zračne snimke 

biti precizne do nekoliko centimetara, dok će snimke napravljene u blizini objekta biti 

precizne do 1 milimetra. Isto tako visoka preciznost digitalnih modela visina, odnosno DEM-

a (eng. Digital elevation model) daju temelje za mjerenje površina i volumena. Program isto 
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tako dozvoljava višestruku obradu fotografija istog mjesta kroz dugotrajan vremenski 

period, te tako može omogućavati praćenje napredovanja u radu površinskog kopa ili pratiti 

eroziju obližnjeg tla. (Kovačić, 2021.) 

2.3 Računalni program CloudCompare 

CloudCompare je softver za uređivanje i obradu 3D oblaka točaka (i trokutaste mreže). 

Izvorno je dizajniran za izravnu usporedbu između gustih 3D oblaka točaka. Oslanja se na 

specifičanu strukturu octree-a koja omogućuje izvrsne performanse pri obavljanju ovakve 

vrste zadatka. Štoviše, kao i većina oblaka točaka stvorenih zemaljskim laserskim 

skenerima, CloudCompare je trebao raditi s ogromnim oblacima točaka na standardnom 

laptopu, obično s više od 10 milijuna točaka (u 2005!). Ubrzo nakon toga, usporedba između 

oblaka točaka i trokuta mreža je podržana. Nakon toga su uslijedili mnogi drugi algoritmi 

za obradu oblaka točaka (registracija, ponovno uzorkovanje, upravljanje bojama/normalnim 

vektorima/skalarnim poljima, izračun statistike, upravljanje senzorima, interaktivna ili 

automatska segmentacija, itd.) kao i alati za poboljšanje prikaza (prilagođene rampe boja, 

boja i rukovanje normalnim vektorima, rukovanje kalibriranim slikama, OpenGL shader-i, 

dodaci itd.). S obzirom na svoju posebnu povijest, CloudCompare gotovo sve 3D entitete 

smatra oblacima točaka. Tipično, trokutasta mreža je samo oblak točaka (vrhovi mreže) s 

pridruženom topologijom (trojke 'povezanih' točaka koje odgovaraju svakom trokutu). Ovo 

objašnjava da mreže uvijek imaju ili oblak točaka nazvan 'vrhovi' kao brata ili roditelja 

(ovisno o načinu na koji su učitani ili generirani). I dok će CloudCompare dopustiti 

korisniku da primijeni neke alate izravno na mrežnu strukturu (odnosno trokute), neki se 

alati mogu primijeniti samo na vrhove mreže. Možda je malo isprva zbunjuće, ali ne želimo 

da korisnik ovo zanemari: CloudCompare je uglavnom softwer za obradu oblaka točaka. 

Naravno, budući da je CloudCompare namijenjen za otkrivanje promjena (npr. praćenje 

slijeganja) i budući da je trokutasta mreža vrlo uobičajen način predstavljanja referentnog 

oblika (npr. zgrade), vrlo je koristan i nije ga se moglo zanemariti. Unatoč tome, on ostaje 

"sekundarni" entitet, pogotovo jer CloudCompare može izravno usporediti dva oblaka 

točaka, bez potrebe za generiranjem posredničke mreže. Među svim 'značajkama' koje se 

mogu povezati s oblakom točaka (boje, normale, itd.) jedna ima posebno mjesto u 

CloudCompare: skalarno polje. Skalarno polje jednostavno je skup vrijednosti (jedna po 

točki - npr. udaljenost svake točke od drugog entiteta). Tako je svaka vrijednost pridružena 

točki (ili vrhu) te je vrijednosti moguće prikazati kao boje (s prilagođenim rampama boja) 
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ili primijeniti filter na njima (glatko, gradijent itd.), neke osnovne matematičke operacije 

(exp, log, potencija 2 ili 3, cos, sin, tan itd.) I naravno segmentirati oblak u odnosu na te 

vrijednosti (prag, lokalno statističko filtriranje itd.). CloudCompare može obraditi više 

skalarnih polja u istom oblaku. (CloudCompare Version 2.6.1 – user manual, 2015.) 
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3. MATERIJAL I METODE 

3.1 Fotografiranje predmeta 

Fotografiranje je odrađeno sa mobilnim uređajem Samsung Galaxy S20 5G, koji posjeduje 

sljedeće tehničke karakteristike:  

Operativni sustav Android 10, One UI2 

Chipset Exynos 990 (7nm+) 

Procesor Octa-core (2x2.73 GHz Mongoose M5 and 

2x2.50 GHz Cortex-A76 and 4x2.0 GHz 

Cortex-A55) 

Grafički procesor Mali-G77 MP11 

Memorija za pohranu 128 GB 

Radna memorija 12 GB, UFS 3.0 

Trostruka kamera 12 MP, f/1.8, 26mm (wide), 1/1.76", 

1.8µm, Dual Pixel PDAF, OIS 

64 MP, f/2.0, 29mm (telephoto), 1/1.72", 

0.8µm, PDAF, OIS, 1.1x optical zoom, 3x 

hybrid zoom 

12 MP, f/2.2, 13mm (ultrawide), 1.4µm, 

Super Steady video 

Značajke kamere LED flash, panorama, auto-HDR 

 

Slika 1. i 2. Mobilni uređaj Samsung Galaxy S20 5G 
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Predmet rada je potrebno fotografirati u jednom smjeru, sa pomacima kamere od 5 ° odnosno 

da sljedeća fotografija ima preklop sa prošlom oko 70 %. Potrebno je slikati iz minimalno 

dva različita kuta kako bi se dobila pokrivenost iz svakog pogleda, odnosno da bi dobila 

točna lokacija predmeta u sve tri dimenzije. U ovom primjeru za predmet rada korišten je 

lemeš pluga sa okretnim dlijetom, koji će biti uspoređen sa identičnim ali korištenim 

lemešom. Nakon što se predmeti fotografiraju, potrebno ih je obraditi u programu Agisoft 

Metashape pomoću kojeg se kreira 3D model. 

 

 

Slika 3. Novi lemeš s okretnim dlijetom 
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Slika 4. Korišteni lemeš s okretnim dlijetom  

 

Za potrebe ovog rada izgrađen je stalak za fotografiranje koji omogućuje da se predmet rada 

postavi na turntable (na bazu), kamera se postavi na nosač na željeni kut fotografiranja, te 

se zbog okretnog ležaja koji se nalazi ispod baze stalka kamera može okretati za željeni 

pomak. To omogućuje da se predmet rada fotografira iz svih kuteva i sa svih strana dovoljno 

precizno kako bi se dobio što kvalitetniji 3D model istog. Prije postavljanja predmeta rada 

na bazu potrebno je na nju postaviti isprintani obrazac na kojem se nalazi fotogrametrijska 

mreža koja omogućuje programu da lakše locira položaj kamere u odnosu na predmet rada 

(preuzeto sa: https://conservancy.umn.edu/handle/11299/172480?show=full). 
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Slika 5. Samograđeni stalak za fotografiranje 

 

3.2 Izrada 3D modela u Agisoft Metashape 

Osim što se gotovo svi objekti mogu fotogrametrijski digitalizirati, moguće ih je i ručno 

izraditi odnosno izmodelirati. 3D modeliranje je tehnika računalne grafike za izradu 3D 

digitalnog prikaza bilo kojeg objekta ili površine. Razvoj računalne tehnologije omogućuje 

korisniku odabir raznih metoda i tehnika kako bi se postigla optimalna učinkovitost. 3D 

tehnikama modeliranja korisnik moţe izraditi 3D model na nekoliko načina: koristeći 

poligone, krivulje ili kombinaciju dviju spomenutih tehnika pod nazivom subdivizijsko 
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modeliranje (eng. subdivision). Odabir ne određuje kvalitetu finalnog proizvoda, ali moţe 

znatno utjecati na vrijeme stvaranja 3D modela. Svaka tehnika uključuje algoritme koji 

korisniku omogućuju izradu i manipuliranje osnovnih primitiva sve do razine sloţenih 

geometrijskih tijela. 3D modeli kao matematička reprezentacija, su u svojoj srži kolekcija 

podataka o točkama u 3D prostoru (eng. vertex, plural vertices) i ostalih informacija koje 

računalo interpretira u virtualni objekt koji nastaje na zaslonu. Osim stvaranja modela kroz 

korištenje specijalnih programa, moguće je kreirati modele kroz razne algoritme 

(proceduralno modeliranje) ili solucijom koja postaje sve popularnija, skeniranjem stvarnog 

objekta i interpretiranjem istog u računalu razumljiv format. Svijet je prepoznao korisnost 

3D modela i općenito 3D grafike, pa se danas koristi u mnoštvu polja. Filmska industrija 

koristi 3D tehnologiju da bi dodala izmišljene likove i objekte u priču ili za veoma opasne 

scene koji ni kaskaderi ne mogu odraditi, pa se to prepušta timu koji je sposoban rekreirati 

određene opasne segmente veoma realno bez ikakvih rizika. U arhitekturi je 3D grafika 

odavno prihvaćena kao vrlo jednostavan i produktivan način da se reprezentira zgrada koja 

bi se trebala izgraditi. Osim navedenog, 3D grafika ima veliku primjenu u medicini, 

znanosti, auto industriji a posebice u industriji video igara. Postoji mnogo načina za nastanak 

nekog 3D modela, ali samo nekoliko tehnika je postalo prilično popularno: poligonalno 

modeliranje, modeliranje krivuljama (eng nurbs) i subdivizijsko (eng. subdivision) 

modeliranje. (Piskrec, 2019.) Postupak izrade 3D modela u računalnom programu Agisoft 

Metashape je rađen prema Beljo (2020.). 
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4. REZULTATI 

4.1 Postupak izrade 3D modela u Agisoft Metashape 

Beljo (2020.) navodi da, nakon što je predmet rada fotografiran iz tri različita kuta, 

fotografije je potrebno prebaciti na računalo. U programu Metashape otvoriti novi radni 

prozor→pod sekcijom Workspace dva puta odabrati Add Chunk. 

 

Slika 6. Add Chunk 
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Slika 7. Add Photos 

 

U odjeljku Workflow odabrati Add Photos kako bi se dodale fotografije. Fotografije je 

potrebno učitati za sva 3 Chunka, odnosno učitati 3 različita kuta slikanja odvojeno.  

Nakon što je program učitao fotografije, u odjeljku Workflow odabrati Align Photos, to 

omogućuje poravnanje fotografija odnosno program pronalazi položaj kamere te svaku 

fotografiju pravilno orijentira jednu prema drugoj. Potrebno je odabrati poravnanje sa 

najvećom preciznošću, time se dobija Sparse point cloud model odnosno dobije se grubi 3D 

model (model sačinjen od točaka). Ovaj proces je dosta dug, te ga je potrebno napraviti za 

sva tri Chunka. 
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Slika 8. Align Photos 

Slika 9. Align Photos 
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Slika 10. Align Photos 

 

Nakon što je proces ponovljen tri puta, dobiven je grubi model koji je potrebno uskladiti sa 

sva tri kuta slikanja. 

 

Slika 11. Prvi model 
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U sekciji photos se odabire prva slika, te je potrebno postaviti markere, pritskom desnog 

klika miša, odabrati Add Marker, markere je potrebno postaviti na istaknute dijelove 

predmeta (brojke, izbočine, korodirana mjesta i na kvadrate koje se nalaze na 

fotogrametrijskoj mreži koja je postavljena ispod predmeta). Program će sam pretpostaviti 

lokaciju markera, ali ih je potrebno sam točno postaviti na mjesto, tako da na svakoj 

fotografiji markeri budu na istoj lokaciji. Markeri na svakoj fotografiji moraju biti na istoj 

lokaciji kako bi program lakše povezao slike i shvatio da je na svakoj sljedećoj fotografiji 

isti predmet samo što je zarotiran. Isti proces ponoviti i na druga dva Chunka. 

 

Slika 12. Postavljanje markera 
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Slika 13. Postavljanje markera 

 

 

Slika 14. Postavljanje markera 
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Slika 15. Build dense cloud 

 

Nakon što su na svakoj fotorgrafiji postavljeni markeri, u odjeljku Workflow odabrati Build 

Dense Cloud. Dense cloud ili točkasti oblak je proces u kojem program na temelju 

procijenjenih pozicija kamera izračunava informacije o dubini svake kamere te ih kombinira 

u jedan točkasti oblak. Ovom procesu također treba vremena, te je potrebno odabrati 

kvalitetu prema snazi računala. Nakon što je stvoren Dense Cloud za sva tri Chunka model 

počinje dobivati pravi izgled. Sljedeće je potrebno odabrati Free-Form Selection te što 

preciznije odabrati dijelove koji nisu predmet slikanja ( u navedenom istraživanju su bili 

stalak, pod, mreža,) te ih obrisati. 
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Slika 16. Free-Form Selection 

 

Nakon uklanjanja nepotrebih Pointova u odjeljku Workflow odabrati Build Mesh. Build 

Mesh ili konstruiranje poligona što omogućava da se do sada sve kreirane točke spoje u 

jednu cjelinu, odnosno da se dobije jedan čvrsti objekt. 

 

Slika 17. Build Mesh 



 

 

23 

 

 

Nakon što je isti proces ponovljen za sva tri dijela u odjeljku Workflow odabrati Align 

Chunks. Tim postupkom se sva tri dijela poravnaju zajedno. 

 

 

Slika 18. Align Chunks 

 

 

Slika 19. Align Chunks 
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U odjeljku Worklfow odabrati Merge Chunks čime će se sva tri dijela spojiti u jedan. Ovime 

se dolazi u završnu fazu stvaranja 3-D modela. 

 

 

Slika 20. Merge Chunks 

 

 

Slika 21. Merge Chunks 
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Nakon što je dobiven Merged Chunk, potrebno ga je pregledati te dodatno urediti. Ako se 

sva tri dijela ne poklapaju pravilno, potrebno je obrisati sve markere te dodati nove, ponoviti 

postupke: Align Chunks (ovaj put umjesto Point based odabrati Marker based) i Merge 

Chunks. Nakon toga ponovno odabrati u Workflow->Build Mesh. Potrebno je ponoviti ovaj 

postupak sa Marker based jer to omogućuje da program preklopi tri modela u jedan onako 

kako mu korisnik postavi, jer kada program sam to radi najčeće ne bude dobro kao i što se 

vidi u primjeru dolje. 

 

 

Slika 22. Point based 
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Slika 23. Marker based  

 

Za kraj je potrebno dodatno očistiti nepravilnosti na modelu, odabirom na pogled Wireframe 

dobit će se precizan pogled na izbočine koje je potrebno ukloniti. Izbočine nastaju kad se 

preklapaju različiti modeli u jedan ili jednostavno nepravilnositi koje su nastale zbog lošeg 

skeniranja. Njih treba odabrati sa Free-selction alatom te ih pritiskom na tipku Delete 

ukloniti. 
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Slika 24. Prije brisanja nepravilnosti 

 

 

Slika 25. Nakon brisanja nepravlinosti 



 

 

28 

 

 

 

Slika 26. Nakon brisanja nepravilnosti 

 

U poslijednjem koraku Workflow->Build Texture program stvara završni model koji nije 

sačinjen od točaka već se tekstura modela stvara izravno sa fotografija, odnosno 3D model 

nakon što dobije teksturu izgleda kao stvarni element. 

 

 

Slika 27. Textured Model 
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Slika 28. Textured Model 

 

 

Slika 29. Textured Model 
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Slika 30. Textured Model 

 

 

Slika 31. Textured Model 

 

Kako bi se krajnji model mogao koristiti sa 3D printerom potrebno je stvoriti poseban model 

doljnje strane predmeta koji se nije mogao vidjeti u ovom procesu. Ponavlja se identičan 

postupak kao i za gornju stranu. Kada se dođe do Align Chunks potrebno je postaviti markere 

tako da se pogramu da do znanja da su oba modela isti model samo okrenuti. 
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Slika 32. Redoslijed markera 4.1.2.3. 

 

 

Slika 33. Redoslijed markera 3.2.1.4. 

 

Nakon što se završi Align Chunks potrebno ih je kao i prije spojiti u jedan, Merge Chunks.  
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Slika 34. Stražnja strana modela 

 

 

Slika 35.Prednja strana modela  

 

Nakon što je model završen, može se napraviti Export iz programa. File->Export->Export 

Model. Nakon toga model se može koristiti u ostalim programima za daljnje uređivanje ili 

za izradu modela na 3D printeru. 
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Slika 36. Stvarni model 

 

 

Slika 37. Stvarni model 
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Slika 38. Dobiveni 3D model 

 

 

Slika 39. Dobiveni 3D model 
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4.2 Mjerenje 3D modela u CloudCompare 

Nakon što je model napravljen, potrebno je napraviti export istog. U programu Metashape 

odabrati File→Export→Export Model…, nakon toga se stvara datoteka u .obj formatu koja 

se može dalje otvoriti u Cloud Compare. Istu radnju je potrebno ponoviti za drugi model. 

 

 

Slika 40. Export modela 

U programu Cloud Compare odabrati File→Open, te odabrati oba modela. 

 

Slika 41. Učitavanje modela 
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Slika 42. Učitani modeli 

 

Nakon što program učita modele, potrebno je odabrati opciju vertices, jer su ovo mesh 

modeli koji na sebi inače nemaju vidljive točke. 

Kada se pojave vertices može se krenuti sa skaliranjem (podešavanjem) modela. Prvo se 

odabire jedan element koji je vidljiv na oba modela to može biti rub, linija ili bilo koji drugi 

pravocrtni element. Ako takvo nešto ne postoji mogu se odabrati dvije određene točke ili 

dva vrha koji su jasno vidljivi u oba modela. Zatim se pomoću opcije Point Picking mjeri 

duljina većeg modela. Ta izmjerena duljina ce predstavljati Dmax koja se dijeli sa duljinom 

manjeg modela Dmin, Sf=Dmax/Dmin. 

Dobiveni faktor je potrebno unijeti kao novi faktor skaliranja. Potrebno je odabrati 

Edit→Multiply/Scale, te upisati dobiveni faktor za sve tri dimenzije. 
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Slika 43. Multiply/Scale 

 

Nakon što su veličine modela podešene, potrebno ih postaviti tako da ih je moguće 

usporediti. Odabrati Tools→Registration →Match bounding box centers, ova opcija će ih 

ugrubo postavit tako da se centri težišta oba modela preklope. 

Nakon toga ih je potrebno ručno postaviti jednog uz drugog, za to se koristi opcija 

Interactive Transformation tool. Sljedeće je potrebno fino registrirati modele. Odabrati 

opciju Fine registration (ICP)  
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Slika 44. Poravnati modeli 

 

 

Slika 45. Fine registration (ICP) 
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Slika 46. Fine registration (ICP) 

 

Nakon što je registracija modela gotova, mogu se točno izračunati dimenzije. Kako se u 

ovom slučaju koriste dva modela, potrebno je odabrati opciju Cloud-to-Mesh Distance. 

 

 

Slika 47. Cloud-to-Mesh Distance 
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Slika 48. Cloud-to-Mesh Distance 

 

Nakon što su modeli registrirani, moguće je vidjeti dobivene rezultate. Razlike u 

dimenzijama na površini su prikazane pomoću boja na skalarnom polju. 

 

 

Slika49. Korišteno dlijeto iznad novog dlijeta 
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Slika 50. Razlike na površinama 

 

 

Slika 51. Razlike na površinama 

 

U posljednjem koraku je ostalo izračunati površinu i obujam oba modela. To će najbolje 

prezentirati razliku između dva ista modela. Odabrati Edit→Mesh→Measure Surface. 
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Slika 52. Measure Surface 

 

Nakon toga odabrati File→Mesh→Measure Volume. 

 

Slika 53. Measure Volume 
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Rezultati mjerenja su vidljivi u konzoli programa, od kuda se mogu dalje isčitati ili prenijeti 

u drugi program. Mjere su prikazane u square unit i cube unit koje predstavljaju mjere iz 

stvarnog svijeta koje su učitane prilikom stvaranja 3D modela. 

Tablica 1. Rezultati mjerenja iz konzole programa  

[21:28:26] [Mesh Surface] Mesh 'StariLemes.registered': S=1.02242 (square units) 

[21:28:26] [Mesh Surface] Average triangle surface: 2.02114e-05 (square units) 

[21:28:26] [Mesh Surface] Mesh 'NoviLemes': S=1.07079 (square units) 

[21:28:26] [Mesh Surface] Average triangle surface: 2.84605e-05 (square units) 

[21:28:30] [Mesh Volume] Mesh 'StariLemes.registered': V=0.657911 (cube units) 

[21:28:31] [Mesh Volume] The above volume might be invalid (mesh has holes) 

[21:28:31] [Mesh Volume] Mesh 'NoviLemes': V=0.746838 (cube units) 

[21:28:31] [Mesh Volume] The above volume might be invalid (mesh has holes) 

 

 

Slika 54. Razlike prikazane Gauss-ovim dijagramom 

Tablica 2. Rezultati mjerenja  

 Površina (square unit) Obujam (cube unit) 

Novo dlijeto 1.07079 0.746838 

Staro dlijeto 1.02242 0.657911 
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5. RASPRAVA 

5.1 Usporedba rezultata dobivenih mjerenjem u CloudCompare 

Na osnovi dobivenih rezultata istraživanja standardnih i navarenih lemeša provedenih na 

pjeskovito-glinastom tlu u Baranji s obzirom na gubitak mase, potrošnju goriva, učinak 

agregata i direktne troškove, mogu se donijeti sljedeći zaključci. Prosječno smanjenje mase 

navarenih lemeša I i II nakon 60 sati rada iznosilo je 11.65 % i 11.64 % početne mase 

odnosno 506.66 i 503.33 g materijala. U isto vrijeme standardni lemeši izgubili su abrazijom 

čestica tla 13.15 %, odnosno 520.00 g od početne mase. Radni agregat opremljen s 

navarenim lemešima II tijekom 120 sati oranja ostvario je prosječni učinak od 0.72 ha/h, s 

navarenim lemešima I 0.70 ha/h, a radni agregat sa standardnim lemešima 0.69 ha/h. 

Tijekom 120 sati oranja standardnim lemešima prosječna potošnja goriva iznosila je 29.56 

L/ha, s navarenim lemešima I 28.62 L/ha, a s navarenim lemešima II 27.40 L/ha. Prosječni 

troškovi goriva i lemeša kod primjene navarenih lemeša II iznosili su 235.49 HRK/ha, nešto 

viši troškovi bili su kod navarenih lemeša I 241.45 HRK/ha, a najviši su troškovi ostvareni 

primjenom standardnih lemeša 256.55 HRK/ha.  Rezultati istraživanja pojedinih čimbenika 

kod navarenih lemeša u usporedbi sa standardnim lemešima daju prednost navarenim 

lemešima, jer su kroz cijelo vrijeme istraživanja zadržali prvobitni oblik, s oštrim vrhom i 

minimalnim oštećenjem oštrice, i pritom ostvarili veći učinak uz manje troškove. (Horvat i 

sur., 2006.) 

Ukupno je pri radu utrošeno 309 sati. Za to vrijeme poorana je površina 226 ha, pri tome je 

uz prosječni učinak 5,1 ha za sedam sati rada utrošeno 1,37 sati/ha. U načelu, svaki raonik 

je tijekom istraživanja poorao 22,6 ha. Ukupna masa svih lemeša prije početka rada iznosila 

je 38625 g. Vaganjem nakon obavljenog oranja ona je bila manja za 8165 g ili 21.13 % od 

početne te je iznosila 30460 g. Svi lemeši se nisu jednako istrošili. Tako su lemeši oznake 

D1 i L1 gubitkom 760 g, odnosno 930 g ili 33,5 % ,odnosno 38,1 % od početne mase postali 

neupotrebljivi za rad. Oni su, u prosjeku, gubili 37,39 g mase po hektaru pooranog tla. 

Gubitak mase praćen je promjenom oblika i smanjenjem površine za 9,01 do 12,81 %. Na 

temelju cijene koštanja od 196,23 HRK po lemešu, utvrđeno je da su troškovi njihove 

primjene na istraživanome tipu tla iznosili 10.06 HRK/ha. Lemeši D2 i L2 imali su prije 

rada prosječnu masu 5750 g. Nakon pooranih 22,6 ha, ona je smanjena za 1070 g ili 18,6 % 

na 4680 g. Njihov prosječni gubitak mase bio je apsolutno najviši i iznosio 47,35 g / ha. 

Treba istaknuti da je tijelo tih lemeša početne mase 4415 g nakon gubitka 625 g ili 14,2 % 
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ostalo i dalje upotrebljivo, dok je vrh s gubitkom 445 g ili 33,3 % od početnih 1335 g postao 

neupotrebljiv. Cijena takvoga lemeša u vrijeme istraživanja bila je 219,44 HRK, a troškovi 

uporabe iznosili su 5,83 HRK/ha. Treću skupinu lemeša činili su lemeši D3, L3 te D4 i L4. 

Njihove su mase prilično ujednačene. Tako je početna masa tijela lemeša prije rada u 

prosjeku iznosila 2350, vrha 1810, a cijeloga lemeša 4160 g. Po završenom oranju, utvrđen 

je ukupni gubitak 770 g ili 18,5 % početne mase. Prosječni gubitak mase po jedinici površine 

iznosio je 34,07 g. U tom je slučaju utvrđeno nešto brže trošenje tijela lemeša, a sporije 

trošenje njegovoga vrha. Tako je tijelo izgubilo 495 g ili 21,1 % a vrh 275 g ili 15,2 %  

početne mase. Cijena nabave i izrade tih lemeša bila je najniža i iznosila je 189,40 HRK po 

komadu. Zbog relativno dobre očuvanosti, osim tijela lemeša D3, rad s tim lemešima mogao 

se nastaviti uz troškove 5,00 HRK/ha. Gubitak površine tijela tih lemeša kretao se između 

5,60 do 13,13 %, a vrha od 7,27 do 10,79 %. Petu su skupinu činili lemeši oznake L5 i D5, 

ukupne početne mase 2885 g. Oni su pri radu gubili u prosjeku 25,44 g/ha. To je u 

apsolutnom iznosu najniži gubitak mase g/ha, ali su po ukupnome gubitku od 575g ili        

19,9 % na drugome mjestu iza lemeša D1 i L1. Troškovi korištenja tih lemeša u postojećim 

odnosima cijene materijala, rada ljudi i energije najniži su i iznose 3,03 HRK/ha. Novčana 

vrijednost svih lemeša prije početka rada iznosila je 2360,44 HRK. Nakon 309 sati rada i 

pooranih 226 ha smanjena je za 1219,04 HRK ili 51,64 % na 1141,40 HRK Prosječni 

troškovi svih lemeša uključenih u istraživanju iznose 5,39 HRK/ha. (Banaj i sur., 2008.) 

Mjernjem površine u CloudCompare-u vidi se da je staro dlijeto u odnosu na novo izgubilo 

0.04837 square unit-a, što iznosi 4,5 % posto gubitka ukupne površine predmeta; mjerenjem 

obujma staro dlijeto je izgubilo 0.088927 cube unit-a, što iznosi 12 % ukupnog obujma 

predmeta. Prema vremenu korištenja i broju obrađenih hektara, da se zaključiti da ovo dlijeto 

prati stupanj trošenja koji je predložila struka. 
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6. ZAKLJUČAK 

S obzirom da je oranje operacija koja iziskuje najviše energetskih i ekonomskih sredstava, 

izrazito je bitno unaprijediti znanje u području trošenja radnih dijelova pluga. Kako je u radu 

navedeno, trošenjem radnih dijelova pluga dolazi do velikih povećanja u potrošnji goriva, 

vučnog otpora, te smanjenja učinka operacije. Iako već postoje metode utvrđivanja 

istrošenosti radnih dijelova, u ovome radu korištena je metoda u kojoj se tehnologijom 

fotogrametrije stvara 3D model koji se kasnijom obradom može detaljno skenirati. Ona 

omogućuje detaljniju analizu trošenja površine materijala. Primjenom ove tehnologije, 

pružit će se mogućnost da se brže, kvalitetnije i još detaljnije analizira trošenje materijala 

što na kraju pridonosi boljem razvoju materijala ali i novih tehničkih rješenja u 

poljoprivrednoj tehnici. 

Obradom fotografija u Agisoft Metashape-u stvoren je 3D model dlijeta lemeša, koji se 

kasnije učitava u program CloudCompare gdje je daljnom obradom moguće detaljno 

skenirati površinu, nakon toga mogu se precizno izmjeriti dimenzije oba modela, što daje 

krajnje rezulate pomoću kojih se utvrio stupanj potrošnje korištenog dlijeta lemeša. 
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